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FCC Part 15 Class B 

This device complies with Part 15 of the FCC Rules.  Operation is subject to the following two conditions:  (1) 
this device may not cause harmful interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation. 

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC rules.  These limits are designed to provide reasonable protection against harmful 
interference in a residential installation.  This equipment generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause harmful interference to radio 
communications.  However, there is no guarantee that interference will not occur in a particular installation.  If 
this equipment does cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try too correct the interference by one or more of the 
following measures: 

• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and the receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

This equipment complies with Canadian and FCC radiation exposure limits set forth for an uncontrolled 
environment.  This equipment is in direct contact with the body of the user under normal operating conditions.  
This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter. 

Part 15.21 Caution: Changes or modifications not expressly approved by Psion Teklogix, Inc. could void the 
user’s authority to operate the equipment. 

Bluetooth Equipped Models: 
This equipment contains either an OEM Serial Port Adapter from connectBlue with FCC ID: PVH070101 or a 
Psion Teklogix, Inc. Bluetooth module with FCC ID: 0113900444. 

Wi-Fi Equipped Models: 
This equipment contains an OEM Wireless LAN Node Module from DPAC Technologies with FCC ID: 
RTTABDB-SEDP.  This device has shown compliance with the conducted emissions limits in 15.107, 15.207, 
or 18.307 adopted under FCC 02-157 (ET Docket 98-80). 

Battery Disposal 

Only dispose of used batteries according to your local regulations.  If you do not know your local 
regulations, the Rechargeable Battery Recycling Corporation (RBRC) is a non-profit organization 
created to promote recycling of rechargeable batteries.  For more information visit www.rbrc.org. 
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 Read all setup and operating instructions before proceeding with operation. 

Do not operate in an enclosure unless properly ventilated.  Make sure no ventilation openings are blocked or 
obstructed, which may result in the printer overheating. 

Do not operate near a heat source. 

 

 Lesen Sie vor der Inbetriebnahme die Aufbau- und Bedienungsanleitung. 

Betreiben Sie den Drucker nicht in einem kleinen, geschlossenen Raum, es sei denn dieser wird ordnungsgemäß 
belüftet. Achten Sie darauf, dass die Lüftungen nicht blockiert oder versperrt sind, denn dies kann zum 
Überhitzen des Druckers führen. 

Nehmen Sie den Drucker nicht in der Nähe einer Wärmequelle in Betrieb. 

 

 

 
No user-serviceable parts inside.  Refer service or repairs to a qualified service 
professional. 

Use of genuine Psion Teklogix replacement parts is required to warrant proper, safe operation.  

Any alteration or modification of this device voids the user warranty and may make the product unsafe to 
operate. 

The print head and motors get hot during use.  Wait until they cool before touching them. 

Make certain the printer is disconnected from AC power before removing any covers or performing any 
required cleaning or maintenance. 

Connecting this printer to an ungrounded receptacle can result in electrical shock. 

Never place the printer near inflammable or explosive substances.  Do not operate near liquid or spill liquid into 
the printer at any time. 

 

 
Enthält keine Teile, die vom Bediener instandgesetzt werden können. Bitte wenden Sie sich bei 
Instandsetzung oder Reparatur an qualifiziertes Kundendienstpersonal. 

Die Verwendung von echten Psion Teklogix Ersatzteilen ist notwendig, um ordnungsgemäßen, sicheren Betrieb 
zu gewährleisten.  

Änderungen oder Modifikationen dieses Geräts machen die Garantie ungültig und können den sicheren Betrieb 
des Produkts gefährden. 

Während des Druckens werden Druckerkopf und Motoren heiß. Warten Sie, bis sich die Teile abgekühlt haben, 
bevor Sie sie berühren. 

Vergewissern Sie sich, dass der Drucker nicht mehr an die Stromquelle angeschlossen ist, bevor Sie 
Abdeckungen abnehmen oder das Gerät reinigen bzw. warten. 

Schließen Sie diesen Drucker nicht an eine ungeerdete Steckdose an; dies kann zum Elektroschock führen. 

Setzen Sie den Drucker niemals in die Nähe von feuer- oder explosionsgefährlichen Stoffen. Betreiben Sie den 
Drucker nicht in der Nähe von Flüssigkeiten und lassen Sie keine Flüssigkeiten in den Drucker gelangen. 
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Introduction 

Thank you for purchasing a Psion Teklogix MLP 3040 Series Mobile Thermal Printer.  The MLP 3040 series 
offer a variety of configurations to suit any printing environment. 

The MLP 3040 series consists of three basic models for receipt and label printing.  The standard MLP 3040 
prints on receipt paper supplied in roll form up to 4.2 inches wide.  The MLP 3040 SL model prints on receipt 
paper up to 4” wide and 6” long supplied in easy to load cassettes containing 100 sheets each.  The MLP 3040 
LP model is able to print on either receipt paper or labels supplied in roll form up to 4.2” wide. 

All models include “black mark” sensing capabilities on the printed side of the media, and the MLP 3040 LP 
also supports rear black mark sensing and label gap sensing.  All models are equipped with a Serial RS-232C 
port and will support one additional, optional interface.  The interfaces available are IrDA, Bluetooth, and  
Wi-Fi. 

Each printer is shipped with a battery, a belt loop system, a two page Quick Start Guide, and either one roll or 
one cassette of receipt paper. 

This manual has been written for the end user and contains information needed for the set up and everyday use 
of the printer.  It also contains information regarding preventative maintenance and how to obtain service if 
needed. 

The information in this manual is arranged in the following sections: 

Getting Started contains the minimum steps required to get the printer set up and able to communicate with 
your host system. 

Daily Operation describes the activities that are likely to be encountered under normal operation by most users. 

Printer Configuration contains detailed information on all the features available in the Setup menus. 

Interfacing To A Host Computer provides basic information related to connecting the printer to a computer via 
the standard RS-232C Serial port or one of the optional IrDA, Bluetooth, or Wi-Fi interfaces. 

Power Considerations provides information regarding operation on the internal battery or from an external 
supply. 

Maintenance and Troubleshooting contains information on how to care for your printer to keep it working at 
peak performance.  This section also includes a list of printer error messages and suggestions on how to solve 
problems. 

Advanced Setup Features contains additional information for systems administrators. 

Print & Font Samples offers examples of printed output and character mapping for the standard fonts. 

Specifications provides detailed information regarding performance, media specifications, and options available 
for your MLP 3040 series printer. 

Glossary of Terms is a reference for terminology used within this manual and in the computer and printer 
industry. 
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Getting Started 

Battery Installation and Charging 

Note:  You must charge the battery for at least 2½ hours prior to the first use. 

The battery for your MLP 3040 printer is shipped in an “uncharged” state.  The battery must be charged using 
the following instructions prior to using the printer for the first time.  Maximum battery capacity is not reached 
until after completing a minimum of three complete charge and discharge cycles. 

Please refer to Figure 1 and insert the battery by sliding it into the battery compartment until the release lever on 
the battery “snaps” into place. 

 

 
Figure 1 - Battery Installation and Power Connector 

Release Lever

Power Connector 

Connect an optional power supply to the appropriate input source, and then connect the output of the power 
supply to the printer’s Power Connector.  The  Battery Indicator will turn on and remain on until the battery is 
fully charged.  This may take up to 2½ hours. 

 Caution: Use only Psion Teklogix power supplies designed specifically for your MLP 3040 printer.  Using a 
different power supply may cause damage to the printer and will not be covered by the printer’s 
warranty.  Psion Teklogix power supplies are available for use with 100-240VAC/50-60Hz and 
for12/24VDC vehicle applications. 
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Getting Started 

Installing Media 

Each printer comes supplied with either a roll of receipt paper or a cassette of receipt paper depending on the 
model you purchased.   

 Note: For maximum performance and optimum print quality, use only genuine Psion Teklogix media in 
your MLP 3040 series printer.   

To install media, you must release the paper door by moving the Paper Door Release in the direction shown in 
Figure 2 and then lift the paper door to expose the paper compartment. 

 

 

 

Paper Supply Indicator

Paper Door Release

Figure 2 - Opening Paper Door 

Please refer to the appropriate section for roll or cassette media depending on your model printer. 

 

Roll Media 
Roll media is used in the MLP 3040 and the MLP 3040 LP printers.  To install media in the MLP 3040 SL 
model, please go to the next section. 

The MLP 3040 and MLP 3040 LP models feature a paper supply indicator as shown in Figure 2.  The indicator 
changes from all green to all red as the paper supply is used. 

To load media, refer to Figure 3 and locate the movable media support.  Move the support in the direction 
shown and then locate the media between the two supports and release the movable support.   

 Note: Make sure that the roll spins freely on the media supports. 
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Getting Started 

 
Figure 3 - Media Support 

Movable Support

 

Refer to Figure 4 and unroll enough paper to allow it to lay through the print head as shown, and close the paper 
door. 

 

 
Figure 4 - Paper Laying Through Print Head 

You may now press the  Paper Feed Button to advance the paper a few inches and then tear it off in 
preparation for printing. 

 

Cassette Media 
The MLP 3040 SL models use cassettes containing 100 sheets of receipt paper.  To open the paper cassette, 
please follow the directions printed on the cassette.  
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Getting Started 

Insert the cassette into the printer as shown in Figure 5.  Make sure that the smooth side of the cassette with the 
Psion Teklogix logo down and the flap side up, and close the paper door. 

 

 
Figure 5 - Cassette In Printer 

 

Turning the Printer On and Off 

To turn the printer on, simply press the  Power Button.  If you continue to hold the Power Button, the printer 
will display the printer’s model number.  After the button is released, the printer will continue its power up 
initialization and then display the name of the current Format (default is “Format 1”) on the top line.  The 
bottom line will display a battery symbol at the right hand end of the line that indicates the current condition of 
the battery. 

To turn the printer off, press and hold the  Power Button.  The printer will display “Printer Off” and then 
power down after the button is released. 

 

Performing A Printer Self Test 

To perform a self test, press and hold the  Paper Feed button while turning on the printer with the  Power 
Button until the printer displays “Printing Current Menu Values”.  The printer will print a test page with the 
following information: 

• The printer’s firmware revision level and release date. 
• The current Setup Menu values for the following menus: 

 The currently selected Format(s) 
 The Options Menu settings. 

• The type of optional interface, if installed, and which interface is currently selected. 
• The presence of the optional Magnetic Card Reader, if installed. 
• The current battery voltage. 
• Print head temperature. 
• A sample bar code. 
• Printer serial number. 
• A print head test pattern. 
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Getting Started 

 

Host Interface Set Up 

Prior to using your printer with a computer application, check the interface settings to be sure they match those 
required by your host system. 

Each printer is equipped with a Serial RS-232C interface which is selected by default.  Additionally, the printer 
may also be equipped with either an IrDA interface, Bluetooth interface, or Wi-Fi interface.  The model 
description on the serial number label will indicate if one of the optional interfaces is installed.  The factory 
defaults for the basic settings for each interface are listed below. 

 

        Interface        Factory Default Interface Settings                                                          

 Serial RS-232C Printek Emulation, 57,600 Baud, 8 Data Bits, 1 Stop Bit, No Parity, No Handshake 

 IrDA Printek Emulation.  No other set up required. 

 Bluetooth Printek Emulation, Pairing Mode = Paired, Security Disabled, PIN = “0” 
Bluetooth Name = “MLP 3040-SerialNumber”. 

 Wi-Fi Connect to any SSID, Infrastructure, WEP = None, DHCP enabled,  
TCP tunnel port 8023, Channel = 1, DHCP Name = MLP 3040-SerialNumber. 

 

If the above settings do not sufficiently match your host system, the following instructions describe how to 
access the Interface Set Up Menu. 

 

1. Make sure the printer is powered off.  If the printer is on, press and hold the  Power Button until 
“Printer Off” is displayed to turn the printer off. 

2. Press and hold the  Enter Button. 

3. Continue to hold the Enter Button and turn the printer on.  Continue holding the  Enter Button until 
“Menus Active” is displayed. 

4. Press the  Advance Button until “Interface Menu” is displayed.  If necessary, you may toggle 
between the Serial interface and the optional interface (if installed) by pressing the  Increment 
Button.  Note that the interface that is displayed is the interface that will be used when you exit set up 
mode. 

5. Press the  Enter Button to advance to the first set up feature for the interface that was displayed in 
step 4.  Only the features that pertain to the interface displayed/selected in step 4 will be available. 

6. You may continue to step through additional set up features by pressing the  Enter Button. 

7. When you have finished setting the parameters to match you host system, press the  Advance Button 
until “Exit Menus” is displayed. 

8. Press the  Enter Button to save the changes and exit the Setup Mode. 

9. Your printer is now configured and ready to communicate with your host system. 
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Getting Started 

Belt Loop System 

The belt loop system consists of two parts – a knob located on the bottom of the printer and a belt loop strap 
with a click on connector 

To use the belt loop system, slide your belt through the strap of the belt loop and then insert the knob located on 
the bottom of the printer into the slot of the belt loop connector.  Pull down on the printer until you hear a click.  
The printer is now secure and can safely hang down beside your hip.  

To release the printer, press in on the two latches on the sides of the connector and pull the printer and knob up 
and clear of the slot. 

 Note: Do not force or pull the printer from the connector without pressing in on the two latches. 

 

 

8 



 

Daily Operation 

 

 

Introduction 

For normal daily use, most users will only need to turn the printer on and off, load paper, and recharge the 
battery at the end of the day.  The following sections describe these simple activities and provide additional 
information regarding the use of the MLP 3040. 

 

 

Control Panel 

The MLP 3040 series printers are designed for simple operation with an easy to use control panel.  As shown in 
Figure 6, the control panel consists of an LCD Display, five indicators, and four pushbuttons.  

 

 
 

Power Indicator 

Wireless Indicator 

MCR Indicator 

LCD Display 

IrDA Window 

Error Indicator 

Battery Indicator 

Enter Button Increment Button 

Power Button 

Paper Feed Button 
/Advance Button 

Figure 6 - Control Panel 

 

In normal daily use, most users will only use the  Power Button/Indicator and perhaps the  Paper Feed 
Button, and observe any messages that may appear on the LCD Display.  The purpose and functionality of all of 
the buttons and indicators are listed below. 

 

 Power Button – Used to turn the printer on or off.   

 Paper Feed  
/Advance Button 

– In Roll Feed models, advances paper 1.25” (32mm).   
In SL models, loads or ejects a sheet of paper.   
Also used to clear Check Paper conditions.   
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Printer Configuration 

 Increment Button – Used in printer configuration menus to change the value of 
the currently selected feature.  (May also be used to access 
a stored command file – see the MLP Series & PrintAbout 
Programmer’s Manual for more information.) 

 Enter Button – Used in printer configuration menus to advance to the next 
setup feature.  May also be used to print the settings and 
connection information for the currently selected interface. 

 Power Indicator – ON indicates that the power is on and that the printer is in 
normal power mode.  SLOW FLASH indicates that the 
printer is in Setup mode and not accepting data.  SHORT 
FLASH indicates that the printer has entered the power 
saving standby mode and will wake upon receipt of data or 
when the  Power Button or  Paper Feed Button is 
pressed. 

 Wireless Indicator – Indicates that an optional Bluetooth or Wi-Fi interface is 
installed enabled and is currently connected or receiving 
data. 

 MCR Indicator – Indicates that the optional Magnetic Card Reader has been 
enabled and is ready for the user to swipe a card. 

 Error Indicator – Indicates that an error has occurred as described on the 
LCD Display. 

 Battery Indicator – ON indicates that the battery is currently being charged.  
FLASHING indicates that the battery capacity is low and 
the battery needs to be recharged. 

 

 

 

 

Removing Printed Output 

Removing printouts from the printer can be as simple as taking hold of the paper and pulling it from the printer.  
This process varies slightly depending on whether your printer uses paper supplied on rolls for the MLP 3040 or 
MLP 3040 LP models, or in cassettes for the MLP 3040 SL models. 

MLP 3040 and MLP 3040 LP Models 
These models make use of a serrated tear bar where the paper exits the printer.  In most cases, the host 
application program will issue a Form Feed that will eject the paper so that all the printed information is fed out 
of the printer and the receipt or label is ready to be torn off.  If all the printing is not yet out of the printer and 
the host has finished sending data to the printer, the paper may be positioned for tearing by simply pressing the 

 Paper Feed Button. 

To tear the paper, pull the paper against the tear bar at a slight angle as shown in Figure 7, and then continue to 
pull the paper in the direction shown to tear it off. 
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Printer Configuration 

 
Figure 7 - Tearing Off Printed Output 

MLP 3040 SL Models 
The MLP 3040 SL models use cassettes of cut sheet receipt paper.  In most cases, the host application program 
will issue a Form Feed that will eject the sheet currently being printed so that it is ready for the user to simply 
pull out of the printer.  If the sheet has not been ejected and the host has finished sending data to the printer, the 
paper may be ejected by pressing the  Paper Feed Button. 

 

 

Battery Charging 

The MLP 3040 contains battery monitoring and charging circuitry so that the battery may be charged while still 
in the printer.  Charging the battery in the printer requires an optional power supply.  Psion Teklogix offers 
power supplies for use with 100-240VAC/50-60Hz and 12/24VDC for vehicle applications.   

Optional external battery chargers are also available so that you can have fully charged batteries “standing by” 
when needed. 

The printer’s battery status is displayed in the lower right corner of the front panel LCD Display.  The status is 
displayed as a battery shape which indicates the relative capacity that remains as indicated below. 

Fully Charged      Discharged 
 

To charge the battery inside the MLP 3040, connect the power supply to the appropriate source, and connect the 
output of the supply to the printer’s power connector shown in Figure 8.   

Caution: Only use Psion Teklogix power supplies to power your printer and charge batteries.  Other power 
supplies may damage the electronics and printing mechanism.  Damage caused by use of a non-Psion 
Teklogix power supply will not be covered by the printer’s warranty. 
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Printer Configuration 

 
Figure 8 - MLP 3040 Power Connector & Battery Indicator 

When the power supply is connected, the printer’s charging circuitry will determine if the battery currently 
requires charging and if so, will turn on the  Battery Indicator until the battery has reached sufficient charge.  
Depending on the condition of the battery, charging may take up to 2½ hours to complete. 

Leaving the power supply connected to the printer will cause the printer to continuously monitor the condition 
of the battery and keep the battery charged. 

For more information regarding battery charging, battery life and battery disposal, refer to “Battery Care” on 
page 40. 

 

 

Using the Magnetic Card Reader 

The optional Magnetic Card Reader (MCR) is used by some applications to read information from credit cards, 
drivers licenses, etc. 

When the host system sends a request to the MLP 3040 to enable the Magnetic Card Reader, “Swipe Card 
Now” will be displayed and the  MCR Indicator will flash to indicate that the card may now be passed through 
the MCR slot, or “swiped”.  Refer to Figure 9 for the card orientation and note the position of the magnetic 
strip. 

 

 
 

Power Connector 
Battery Indicator

MCR Indicator

Figure 9 - Using The Magnetic Card Reader 
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Printer Configuration 

If the card is read successfully, a short beep will sound, “Card Read Ok” will be displayed and the  MCR 
Indicator will stop flashing and remain on briefly to indicate success as the data is sent to the host system.   

If the card is not read successfully, a longer error tone will sound, “Card Not Read” will be displayed and the  
Error Indicator will also begin to flash.  If the read operation is not cancelled by the host application within a 
few seconds, the  Error Indicator will stop flashing and the printer will return to the “Swipe Card Now” 
mode.  At this time the card may be swiped again to attempt a successful read.   

The length of time allowed before the timeout is specified by the host application program.  Once a timeout 
occurs, the  Error Indicator will turn on momentarily and “MCR Timeout” will be displayed. 

 

 

 

 

 

Additional Messages 

Check Paper 
This message is displayed and the  Error Indicator flashes whenever the printer runs out of print media.  This 
may also occur if there has been a paper jam that prevents paper from feeding into the print head.  To clear the 
error, first clear the jam and/or install new media.  For information on how to replace the media supply or to 
check for a possible jam, please refer to “Installing Media” on page 4 in the Getting Started section of this 
manual. 

Next, momentarily press the  Paper Feed Button to resume printing.  After the error has been cleared, printing 
may resume differently depending on the model printer you are using. 

In the MLP 3040 and MLP 3040 LP models with printer firmware prior to version 2.8, printing will begin again 
where it left off.  If the printer has firmware version 2.8 or later, the printer will perform a Form Feed and then 
reprint the last print job.  If the entire job does not print as expected, the host program may need to be modified 
to make use of the printer’s buffer commands.  Please refer to the MLP Series & PrintAbout Programmer’s 
Manual for more information. 

In the MLP 3040 SL model, printing will restart at the beginning of the current page.  If the Check Paper error 
occurred at the beginning of a page, the printer will load a page from the new cassette and continue.  If, for 
some reason, the Check Paper error occurred mid page, the printer will reprint the entire page after a new 
cassette has been loaded. 

It is also possible that a false paper error may be detected when using “black mark” sensing on preprinted 
forms.  This condition should not occur unless the size of the black mark on the form is larger than the size 
allowed for in the host application program.  Please refer to the MLP 3040 Series Programmer’s Manual for 
more information. 

Paper Door Open 

This message is displayed and the  Error Indicator flashes when the printer is attempting to print and the 
Paper Door is not fully closed.  To correct this error, make sure that the media is loaded properly, close the 
Paper Door, and momentarily press the  Paper Feed Button. 
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Printer Configuration 

Printer Configuration 

Introduction To Setup 

The MLP 3040 series printers feature an easy to use control panel “Setup” menu system for setting permanent 
configuration parameters.  These menus offer many useful and necessary features, but are typically only used 
when first setting up the printer.  They are rarely used in normal everyday operation.  The values that are set are 
used as the “defaults” whenever the printer is turned on or reset by the host system.  Application programs often 
send commands that may override any of these values. 

As an alternative to using the Setup Menus described below, you may also use the “MLP Setup” remote 
configuration utility.  This utility runs on a Windows Desktop system and connects to the printer’s serial port. 

 

 

 

Setup Basics 

 

Power Indicator 

LCD Display 

 

 

Figure 10 - MLP 3040 Control Panel 

 

When in Setup, the top line of the LCD Display shows the name of the menu or the name of a “feature” within 
the menu.  The bottom line of the display shows the current value that is set to be used for the item displayed on 
the top line.   

The Setup menus operate as a “What You See Is What You Get” system.  This means that whenever you view 
or change any of the menu choices available, the value showing when you proceed to the next item or exit Setup 
is the value the printer will use after you exit Setup.  Note that when exiting Setup, you may elect to discard any 
changes. 

Enter Button Increment Button 

Power Button 

Advance Button 
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Printer Configuration 

Entering Setup 
To enter Setup, press and hold the  Enter Button while turning on the printer with the  Power Button.  
Continue to hold the Enter Button until “Menus Active” appears on the LCD Display.  After releasing the  
Enter Button, “Entering Setup Menus” will be displayed momentarily before advancing to the “FORMAT 
MENU”.  While in Setup Mode, the power indicator will blink slowly.   

 

 

Selecting Menus 

Once Setup Mode has been successfully entered, the “FORMAT MENU” is the first menu displayed.  Note that 
while in Setup Mode, the  Paper Feed Button now operates as an  Advance Button.  To advance to the 
INTERFACE MENU or OPTIONS MENU, or to Exit Setup, press the  Advance Button until the desired 
menu is displayed.  With a few exceptions which are described where appropriate, pressing the  Advance 
Button will always advance you to the next menu. 

Detailed explanations on how to navigate each of the menus and use their features follow. 

 

 

Exiting Setup 
Setup may be exited by pressing the  Advance Button until “Exit Setup” is displayed on the top line of the 
LCD Display, and “Save Changes” is displayed on the bottom line.  To save any changes you have made 
and exit Setup press the  Enter Button.  If feature values were changed, “Exiting Menus Saving 
Changes” will be displayed.  If no values where changed, “Exiting Menus No Changes” will be 
displayed. 

If you do not want to save the changes you have made, press the  Increment Button to display “Discard 
Changes” on the bottom line and then press the  Enter Button.  “Exiting Setup No Changes” will be 
displayed. 

After Setup is exited and any changes saved, the printer will reset and reinitialize itself to adopt any changes 
that may have been made.  Note that when this reset occurs, any data that may have been in the input buffer will 
be discarded. 
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Setup Menu Summary 
The following table is a summary of the features and possible values available in the Format, Interface, and 
Options Menus.  This table may be used to help locate a particular item, or as a “quick reference” for the Setup 
menu system. 

 

 

Setup Menu Summary 
Format Menu Interface Menu 
Format n Serial IrDA Bluetooth Wi-Fi 

Options Menu

Format Name 
  Up to 16 Characters 

Font 
  4.2, 5.5, 10.2, 10.7,  
  18.5, 20.3 SansSerifA;  
  12.7, 13.5, 14.5, 15.6,  
  16.9*, 18.5, 20.3, 22.6,  
  25.4 Courier 

Spacing 
  0 - 10, 3* 

Left Margin 
  0* - 1.0244” 

Right Margin 
  0* - 1.2608” 

Print Contrast 
  -75 to +125, 0* 
  (+35* for LP Models) 

Max Paper Speed 
  0.32 to 3.30* ips 
  (2.30* for LP Models) 

Form Feed Distance 
  0 – 2.5216”, 1.2608* 
  (Mark Sensing for  
  LP Models) 

Mark Sensing 
  Front*, Back, Gap 
  (Back* for LP Models) 

Mark Sensitivity 
  -10 to +10, 0* 

Gap Sensitivity 
  -10 to +10, 0* 

Tear to Mark Dst 
  -0.7092” to 1.7927”, 0* 

Present Distance 
  0.0000”* to 1.2911” 

Emulation 
  Printek*, O’Neil, 
  ZPL-II, Mt3,  
  CPCL, Hex Dump 

Baud Rate 
  9600, 19200,  
  38400, 57600* 

Data Bits 
  7, 8* 

Stop Bits 
  1*, 2 

Parity 
  None*, Even,  
  Odd 

XON/XOFF 
  Off*, On 

ETX/ACK 
  Off*, On 

RTS/CTS 
  Off, On* 

Emulation
  Printek*,  
  O’Neil,  
  ZPL-II,  
  Mt3, 
  CPCL,   
  Hex Dump

Emulation 
  Printek*, O’Neil,  
  ZPL-II, Mt3,  
  CPCL, Hex Dump 

Pairing Mode 
  Paired*, Unpaired 

Role Policy 
  Defer*, Master 

Discoverability 
  On*/Off 

Pin 
  0*, Up to 16  
  Numeric Chars. 

Security 
  Off*, On 

Local Name 
  MLP 3040-
Serial#* 

Address 
  (Displayed Only) 

Emulation 
  Printek*, O’Neil, 
  ZPL-II, Mt3,  
  CPCL, Hex Dump 

WLAN Type 
  Infrastructure*,  
  Peer-to-Peer 

WLAN Channel 
  1* – 14 

WLAN SSID 
  any* 

WLAN WEP Bits 
  0*, 64, 128 

WEP Key 1-4 
  10 or 26 Char. 
  Hex String 
  “000…0”* 

WLAN Auth 
  Auto*, Open,  
  Shared 

IP Address Assign 
  DHCP*, Static 

IP Address 
  0.0.0.0* 

IP Subnet Mask 
  0.0.0.0* 

IP Gateway 
  0.0.0.0* 

Tunnel Port# 
  08023* 

Max Format # 
  1* – 5 

Auto Power Down
  Off*,  
  1 – 15 Minutes 

User Language 
  English*, French, 
  German 

Truncate Lines 
  No*, Yes  

Print Promo 
  No*, Yes 
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Format Menu 

 FORMAT MENU 
Current Format

 

The MLP 3040 supports five “Formats” or sets of printing parameters that may be selected either through the 
control panel or by host application programs.  These Formats include printing related features such as Form 
Length, Font, Character Pitch, Margins, etc.  Each Format also includes the ability to name the Format with a 
name such as “Receipt”, “Routing Label”, or “Shipping Label”, etc.   

Upon entering Setup as described earlier in “Setup Basics”, the Format Menu is the first menu that will appear.   

The bottom line of the display shows the Format that is currently selected.  If you wish to change to a different 
format, press the  Increment Button until the desired Format is displayed.   

 Note: If you wish to use more than one Format, you must first enable additional Formats.  Please refer to 
the “Max Format” feature in the “Options Menu” on page 29. 

Once the desired Format is displayed, you may do one of the following: 

press the  Enter Button to review and/or change the features related to the displayed Format, or 

press the  Advance Button to advance to the INTERFACE MENU 

Pressing the  Enter Button will advance through the following features for the selected Format in the order 
listed below. 

 

 

 

Format Name Format Name 
Format 1

 

Possible Values: Up to 16 characters of A through Z, 0 through 9, SPACE 

When shipped from the factory, the name for each format will be “FORMAT 1”, “FORMAT 2”, etc.  This 
name may be changed to any combination of capital letters (A-Z), numerals (0-9), or spaces.  The name may be 
up to 16 characters in length. 

To advance through the character positions of the name, press the  Advance Button.  To change the character 
at the current position, press the  Increment Button.  The order of characters that may be selected is 
“ABCDEFGHIJKLMNOPQRSTUVWXYZ  SPACE  0123456789”.  The name will automatically be centered 
on the display after exiting Setup, so there is no need to try to center it with spaces. 
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Font Font 
16.9 cpi Courier

 

Possible Values: 4.2 cpi SnsSrfA 16.9 cpi SnsSrfA 
5.5 cpi SnsSrfA 16.9 cpi Courier* 
10.2 cpi SnsSrfA 18.5 cpi SnsSrfA 
10.7 cpi SnsSrfA 18.5 cpi Courier 
12.7 cpi Courier 20.3 cpi SnsSrfA 
13.5 cpi Courier 20.3 cpi Courier 
14.5 cpi Courier 22.6 cpi Courier 
15.6 cpi Courier 25.4 cpi Courier 
 
Any downloaded fonts will also be displayed. 

This feature selects the default font and character pitch. 

 

 

Spacing Spacing 
3 Lines

 

Possible Values:  0 … 3* … 10 Lines 

When printing text, this feature sets spacing between lines.  The height of a complete line, or line pitch, is 
determined by adding the vertical size of the current font to the Spacing.  With Spacing set to the default value 
of “3” and using a font that is 23 rows high, the line pitch would be 3 + 23, or 26 dot rows.  Since each dot row 
is 0.125mm, 26 x 0.125 yields a line pitch of 3.25mm or 7.8 lines per inch.  This line pitch value also 
determines the amount of paper motion performed when an ASCII Line Feed character is received by the 
printer. 

When printing PC Line drawing characters, Spacing should be set to “0” to avoid space between rows of 
characters used to draw vertical lines. 

When printing graphic data, Spacing has no affect so that multiple lines of graphics may print adjacent to each 
other. 

 

 

Left Margin Left Margin 
0.0000”

 

Possible Values:  0.0000”* … 1.0244” in increments of 0.0394” 

This feature sets the left margin in inches relative to the leftmost printing position.  The left margin must be less 
than the right margin.   
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Right Margin Right Margin 
0.0000”

 

Possible Values:  0.0000”* … 1.2608” in increments of 0.0394” 

This feature sets the right margin in inches relative to the rightmost printing position.   

Text characters that would have printed to the right of the margin will either be “wrapped around” and printed 
on the next line, or will be discarded based on the setting for “Truncate Lines” in the Options Menu. 

Graphic data that would have printed to the right of the margin will be truncated. 

 Note: The MLP 3040 has a maximum print width of 4.1”.  However, when Mt3 Emulation has been 
selected, the Right Margin will begin indenting from a maximum print width of 2.84” to match the 
characteristics of the Psion Teklogix Mt3 Series printers.  

 

 

Print Contrast Print Contrast 
0

 

Possible Values:  -75 … 0* … +125 in increments of 5 (+35* for LP Models) 

The printer automatically adjusts the amount energy used in order to maintain constant print quality as the 
battery discharges during use.  The Print Contrast setting modifies the value that is determined to be needed by 
the printer and may be used to obtain improved print quality on different qualities of thermal print media.   

 Note: By affecting the relative amount of battery energy that is used when printing, the Print Contrast 
setting affects both print speed and battery life.  Setting a lower value will result in faster printing 
and will extend normal battery life.  Setting a higher value may allow the use of poorer quality media 
and will result in slower printing and a shorter battery life. 

 

 

Maximum Paper Speed Max Paper Speed 
3.30 ips

 

Possible Values: Standard Roll Feed Models – 0.32 …3.30* ips 
  LP Models – 0.32 … 2.30* … 3.30 ips 
  SL Models – 0.32 …2.30* ips 

This feature may be used to reduce the maximum paper speed if necessary to allow the printer to use heavier 
papers, labels, narrow paper or labels, or some coated papers that have a more slippery finish.   

 

 

Form Feed Distance FFeed Distance 
1.2608

 

Possible Values: 1.0000 … 1.2608* … 2.5216 inches 

This feature sets the distance that paper is to be moved whenever the user presses the  Paper Feed Button or a 
Form Feed character is received from a host system.   

 Note: This feature is available in printers with firmware revision 2.0 and higher. 
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Mark Sensing Mark Sensing 
Front

 

Possible Values:  Front*, Back, Gap (Back* for LP Models) 

Mark Sensing is used to identify form or label position marking and must be set to match the media being used.  
The use of Black Mark or Gap sensing is associated with the design of the application program that is 
controlling the printer.  For more information on Black Mark or Gap sensing, please refer to the MLP 3040 
Series Programmer’s Manual.   

 Note: This feature is only available in MLP 3040 LP models. 

 

 

Mark Sensitivity Mark Sensitivity 
0

 

Possible Values:  -10 …0* …+10 

This feature allows the Black Mark/Paper sensor to be adjusted to allow for variations in media materials and 
Black Mark printing methods.  The following list will help determine if, and how, the Mark Sensitivity should 
be adjusted. 

• If the printer is not detecting black marks reliably, set the Mark Sensitivity to a lower value. 
• If the printer is detecting false Check Paper conditions, set the Mark Sensitivity to a higher value. 
• If the printer is detecting black marks where none exist, set the Mark Sensitivity to a higher value. 

 

 

Gap Sensitivity Gap Sensitivity 
0

 

Possible Values:  -10 …0* …+10 

This feature is used to adjust the sensing of gaps between labels when using precut labels that are provided on a 
removable backing.  The following method should be used to adjust the gap sensor. 

• If the printer is not detecting gaps between labels reliably, set the Gap Sensitivity to a higher value. 
• If the printer is detecting gaps where none exist, set the Gap Sensitivity to a lower value. 

 Note: This feature is only available in MLP 3040 LP models. 

 

 

Tear to Mark Distance Tear to Mark Dst 
0.0000”

 

Possible Values:  -0.7092” …0.0000”* …1.7927” 

This feature is used to set the distance from the tear position on the paper/labels to the black mark.  If the tear 
position is above the black mark, the value is negative.  If the tear position is below the black mark, the value is 
positive. 
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Present Distance Present Distance 
0.0000”

 

Possible Values:  0.0000”* …1.2911” 

This feature sets the distance the paper is moved forward after the black mark is sensed.  When the black mark 
is sensed, the paper will be fed forward by this amount to allow for tearing or peeling of a label.  When the next 
print job begins, the paper will be reverse fed this same amount before printing begins. 

When the Tear to Mark Distance is a negative value, this is typically set to the inverse of that value. 

 

 

 

Interface Menu 

 INTERFACE MENU 
Current Host I/O

 

After entering Setup as described earlier in “Setup Basics”, press the  Advance Button until “INTERFACE 
MENU” is displayed on the top line.   

The bottom line displays the currently selected host interface.  The Interface Menu provides access to the 
features that may be configured for the currently selected interface.   

Note that the Serial interface is standard in all MLP 3040 series printers.  If another, optional interface such as 
IrDA, Bluetooth, or Wi-Fi is installed, you may select between the Serial interface and the optional interface by 
pressing the  Arrow Button.  Once the desired interface is displayed, you may do one of the following: 

press the  Enter Button to review and/or change the features related to the selected interface, or 

press the  Advance Button to advance to the OPTIONS MENU 

 

Pressing the  Enter Button will advance through the following features for the selected Interface in the order 
listed below.   

Please refer to “Interfacing To A Host Computer” on page 33 for additional information. 

 

Serial Interface 
 

 INTERFACE MENU 
Serial

 

Note that “Serial” must be displayed on the bottom line of the display in order to access the following 
features and for this interface to be active when Setup is exited. 
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Emulation Emulation 
Printek

 

Possible Values:  Printek*, O’Neil, ZPL-II, Mt3, CPCL, Hex Dump 

This feature sets the family of printer commands that may be used by a host application program to control the 
various capabilities of the printer.  The printer will only respond to commands valid for the currently selected 
emulation.  For more information, please refer to the MLP 3040 Series Programmer’s Manual. 

 

 

Baud Rate Baud Rate 
57600

 

Possible Values:  9600, 19200, 38400, 57600* 

This feature sets the baud rate for the Serial interface.  The value must match the setting used on the host 
system. 

 

 

Data Bits Data Bits 
8

 

Possible Values:  7, 8* 

This feature sets the number of data bits in the serial character frame.  The value must match the setting used on 
the host system. 

 

 

Stop Bits Stop Bits 
1

 

Possible Values:  1*, 2 

This feature sets the number of stop bits included in the serial character frame.  The value must match the 
setting used on the host system. 

 

 

Parity Parity 
None

 

Possible Values:  None*, Even, Odd 

This feature sets the parity checking requirements for the data bits in the serial character frame.  The value must 
match the setting used on the host system. 
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XON/XOFF Handshaking XON/XOFF 
Off

 

Possible Values:  Off*, On 

This feature enables or disables the XON/XOFF (DC1/DC3) character handshaking method used to control data 
flow from the host system to the printer.  When enabled, an XOFF character will be sent by the printer 
whenever the printer’s input buffer is nearly full.  An XON character will be sent whenever the printer’s input 
buffer becomes nearly empty or if the control panel Setup Mode has been exited. 

 

 

ETX/ACK Handshaking ETX/ACK 
Off

 

Possible Values:  Off*, On 

This feature enables or disables the ETX/ACK character handshaking method used to control data flow from the 
host system to the printer.  When enabled, an ACK character will be sent by the printer after an ETX character 
has been received and processed out of the input buffer.  ETX characters used for handshaking cannot be part of 
an escape sequence. 

 

 

RTS/CTS Handshaking RTS/CTS 
On

 

Possible Values:  Off, On* 

This feature enables or disables the RTS/CTS hardware handshaking method used to control data flow from the 
host system to the printer.  When enabled, the printer will activate the RTS signal whenever the printer’s input 
buffer becomes nearly empty or when the printer’s control panel Setup Menus are active.  The RTS signal will 
be deasserted whenever the printer’s input buffer becomes nearly empty or Setup Mode has been exited. 

Likewise, the printer will not send data to the host system if the host has asserted the CTS signal. 

 

 

IrDA Interface 

 

 INTERFACE MENU 
IrDA

 

Note that “IrDA” must be displayed on the bottom line of the display in order to access the following features 
and for this interface to be active when Setup is exited. 
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Emulation Emulation 
Printek

 

Possible Values:  Printek*, O’Neil, ZPL-II, Mt3, CPCL, Hex Dump 

This feature sets the family of printer commands that may be used by a host application program to control the 
various capabilities of the printer.  The printer will only respond to commands valid for the currently selected 
emulation.  For more information, please refer to the MLP 3040 Series Programmer’s Manual. 

 

Bluetooth Interface 

 

 INTERFACE MENU 
Bluetooth

 

Note that “Bluetooth” must be displayed on the bottom line of the display in order to access the following 
features and for this interface to be active when Setup is exited. 

 

 

Emulation Emulation 
Printek

 

Possible Values:  Printek*, O’Neil, ZPL-II, Mt3, CPCL, Hex Dump 

This feature sets the family of printer commands that may be used by a host application program to control the 
various capabilities of the printer.  The printer will only respond to commands valid for the currently selected 
emulation.  For more information, please refer to the MLP 3040 Series Programmer’s Manual. 

 

 Note: After pressing the  Enter Button to move from Emulation to Pairing Mode, the printer will pause 
and display “Waiting for Bluetooth” while reading the current configuration from the Bluetooth 
interface module. 

 

Pairing Mode Pairing Mode 
Paired

 

Possible Values:  Paired*, Unpaired 

This feature allows Bluetooth pairing to occur between the printer and the connecting device whenever Security 
is required by either device.  Pairing requires that the PIN on the printer and the connecting exactly match each 
other. 
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Role Policy Role Policy 
Defer

 

Possible Values:  Defer*, Master 

Note that this feature is only available in firmware version 2.8 or later.  

This feature selects the role of the printer’s interface in the Bluetooth network.   

If the device attempting to communicate with the printer is having trouble discovering the printer, setting the 
value to Master may correct the problem. 

 

 

Discoverability Discoverability 
On

 

Possible Values:  Off, On* 

This feature is used to set whether the printer may be discovered by other Bluetooth devices. 

 

 

PIN PIN 
0

 

Possible Values:  0*, Up to 16 Numeric Characters. 

Note that this feature is only available if Paring Mode is set to Paired.  

To advance through the character positions, press the  Advance Button.  To change the character at the current 
position, press the  Increment Button.  The characters that may be selected are “0123456789” and SPACE.  
Setting a character to SPACE will terminate the value being set. 

 

 

Security Security 
Off

 

Possible Values:  Off*, On 

Setting Security to On forces the printer and the remote device to use pairing.  Setting Security On requires that 
Pairing is set to Paired and that a PIN has been entered that matches the PIN in the remote device. 
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Local Name Local Name 
MLP 3040-
AAANNNNN

 

Possible Values: MLP 3040-aaannnnn*,  
  Up to 16 characters of “0” through “9”, “A” through “Z”, “a” through “z”, “-“, “_”, SPACE 

This feature sets the name that will be displayed by most host systems when “discovering” the printer.  When 
shipped from the factory, the default value for the Bluetooth Local Name is “MLP 3040-aaannnnn” where 
“aaannnnn” is the printer’s serial number.  This name may be changed to any combination of letters, numbers, 
dashes, underscores, and SPACEs.  The name may be up to 16 characters in length. 

To advance through the character positions of the name, press the  Advance Button.  To change the character 
at the current position, press the  Increment Button.  The order of characters that may be selected is 
“0123456789  ABCDEFGHIJKLMNOPQRSTUVWXYZ  abcdefghijklmnopqrstuvwxyz  -  _  SPACE”.   

 

 

Address Address 
0080371B8F32

 

Possible Values:  Twelve digit hexadecimal string. 

This feature displays the unique hardware value associated with the particular Bluetooth interface installed in 
the printer.  This value is set by the hardware manufacturer, is guaranteed to be unique for each interface, and 
may not be changed. 

 

Wi-Fi Interface 
 

 INTERFACE MENU 
Wi-Fi

 

Note that “Wi-Fi” must be displayed on the bottom line of the display in order to access the following features 
and for this interface to be active when Setup is exited. 

 

 

Emulation Emulation 
Printek

 

Possible Values:  Printek*, O’Neil, ZPL-II, Mt3, CPCL, Hex Dump 

This feature sets the family of printer commands that may be used by a host application program to control the 
various capabilities of the printer.  The printer will only respond to commands valid for the currently selected 
emulation.  For more information, please refer to the MLP 3040 Series Programmer’s Manual. 
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 Note: After pressing the  Enter Button to move from Emulation to WLAN Type, the printer will pause 
and display “Waiting for Wi-Fi” while reading the current configuration from the Bluetooth interface 
module. 

WLAN Type WLAN Type 
Infrastructure

 

Possible Values:  Infrastructure*, Peer-to-Peer 

This feature specifies the type of wireless network the printer will be attached to.  An Infrastructure network 
consists of nodes that connect to each other and/or a wired network through an Access Point.  A Peer-to-Peer, or 
Ad-Hoc, network consists of nodes that connect directly to each other without the control of an access point. 

 

 

WLAN Channel WLAN Channel 
1

 

Possible Values:  1* … 14 

Note that this feature is only available if the WLAN Type is set to Peer-to-Peer. 

This feature sets the radio channel to be used when communicating in a Peer-to-Peer network.  When in an 
Infrastructure network, the radio channel is automatically assigned by the interface and Access Point. 

 

 

WLAN SSID WLAN SSID 
any

 

Possible Values: any*, 
  Up to 16 characters of “0” through “9”, “A” through “Z”, “a” through “z”, 

This feature specifies the “name” of the network the printer will connect to.  This allows communications to be 
controlled, or routed to the appropriate nodes when multiple wireless networks are present.  When set to “any”, 
the printer may connect to any available network(s). 

To advance through the character positions, press the  Advance Button.  To change the character at the current 
position, press the  Increment Button.  The order of characters that may be selected is “0123456789  
ABCDEFGHIJKLMNOPQRSTUVWXYZ  abcdefghijklmnopqrstuvwxyz”. 

 

 

WLAN WEP Bits WLAN WEP Bits 
0

 

Possible Values:  0*, 64, 128 

This feature specifies the level of Wired Equivalent Security to use.  If set to “0”, security is turned off.  If set to 
a“64” or “128” bit encryption level, a WEP Key must be entered that matches the key on the other nodes on the 
network. 
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Key1: 1234567890 
 

WEP Key 1 
WEP Key 2 
WEP Key 3 
WEP Key 4 – OR – 

 Key1: 0123456789 
01234567890ABCDE

 

Possible Values:  10 or 26 character user specified hexadecimal string 

Note that this feature is only available if WLAN WEP Bits is set to 64 or 128. 

This feature specifies an encryption “key” or password that is used to encrypt/decrypt data on the network.  If 
WLAN WEP Bits is set to “64”, a ten character hexadecimal string must be entered that matches the key on the 
other nodes the printer will be communicating with.  If WLAN WEP Bits is set to “128”, a 26 character 
hexadecimal string must be entered. 

 

 

WLAN Auth WLAN Auth 
Auto

 

Possible Values:  Auto*, Open, Shared 

This feature specifies the authentication method that will be used when establishing connections on the network.  
The method may be to use an open key or a shared key.  If set to “Auto”, the printer will automatically match 
itself to the method used by other nodes. 

 

 

IP Address Assign IP Addr Assign 
DHCP

 

Possible Values:  DHCP*, Static 

This features specifies whether the printer will obtain an IP address from a DHCP server, or if an IP address 
will be manually assigned. 

 

 

IP Address IP Address 
0.0.0.0

 

Possible Values:  0.0.0.0*, User specified 

This feature specifies the IP address for the printer. 

Note that this feature has no effect if IP Address Method is not set to “Static”. 
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IP Subnet Mask IP Subnet Mask 
0.0.0.0

 

Possible Values:  0.0.0.0*, User specified 

This feature specifies the range of addresses, or the size of the network, which the printer’s IP address belongs 
to. 

Note that this feature has no effect if IP Address Method is not set to “Static”. 

 

 

IP Gateway IP Gateway 
0.0.0.0

 

Possible Values:  0.0.0.0*, User specified 

This feature specifies the network node where data destined for a node outside of the LAN should be directed. 

Note that this feature has no effect if IP Address Method is not set to “Static”. 

 

 

Tunnel Port Number Tunnel Port# 
08023

 

Possible Values:  00000 … 08023* … 65384 

This feature specifies the TCP/IP port to be used for data that is to be printed. 

To advance through the character positions, press the  Advance Button.  To change the character at the current 
position, press the  Increment Button. 

 Note: This feature is available in printers with firmware revision 2.0 and higher. 

 

 

 

Options Menu 

 OPTIONS MENU 
 

 

The OPTIONS MENU contains features that affect how the printer operates regardless of how features in other 
menus have been set. 

After entering Setup as described earlier in “Setup Basics”, press the  Advance Button until “OPTIONS 
MENU” is displayed on the top line.  You may now do one of the following: 

press the  Enter Button to review and/or change the features available, or 
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press the  Advance Button to advance to the TEST MENU

 

Pressing the  Enter Button will advance through the following features in the order shown below.   

Maximum Format Number Max Formats 
Format 1

 

Possible Values:  Format 1* … Format 5

This feature sets the highest Format number to be displayed in the Format Menu.  This allows the operator to 
see only the formats that are in use rather than having to potentially sort through several unused formats. 

Note that when changing the value of this feature, you may not select a value less than the value currently set in 
the Format Menu. 

 

 

Auto Power Down Auto Power Down 
Off

 

Possible Values:  Off*, 1 Minute Delay … 15 Minute Delay 

This feature sets whether the printer will automatically power down and if so, after what period of time of 
inactivity.  If set to a value other that “Off”, the printer will automatically turn itself off after the specified 
number of minutes have passed since the printer last received data or last printed, whichever is longer. 

 

 

User Language User Language 
English

 

Possible Values:  English*, French, German 

This feature specifies the language to be used when presenting information on the control panel’s LCD Display. 

 

 

Truncate Lines Truncate Lines 
No

 

Possible Values:  No*, Yes 

This feature specifies what is to be done with data that will not fit within the printable area of the current 
Format.  The printable area is defined as the printable line length of the print head (approximately 4.1 inches) 
minus the area specified by the left and right margin. 

When printing text, a value of “No” will cause excess data to be “wrapped around” and printed at the beginning 
of the next line.  A value of “Yes” will cause the excess data to be discarded. 

When printing graphics, excess data will always be discarded. 
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Print Promotion Print Promo 
No

 

Possible Values:  No*, Yes 

This feature is only available in firmware version 2.8 or later.  

 

When set to “Yes” this feature causes a previously stored graphic image with an ID value of “$” to be printed at 
the end of each print job. 

This feature may be used to print a special logo or graphic image of a special sales promotion or other event that 
also needs to be enabled/disabled by the user in the field. 

 Note: In firmware version 2.9 and later, multiple graphic images may be stored with the ID values of “!”, 
“@”, “#”, “$”, “%”, “^”, “&”, “*”, “(“, and/or “)”.  In this case, the printer will automatically cycle 
through each of these images printing one at the end of each print job. 

Please refer to the MLP Series & PrintAbout Programmer’s Manual for more information on storing graphics 
and logos. 
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Interfacing To A Host Computer 

Every MLP 3040 is equipped with an RS-232C Serial Interface.  Optional factory installed interfaces are also 
available for IrDA (Infrared), Bluetooth®, and Wi-Fi®.  When the printer is equipped with one of the optional 
interfaces, the interface that is selected in the Interface Menu as described on page 21 is the one that will be 
active and the other interface will be ignored. 

 Note: To print out configuration information for the currently selected interface, you may press and hold 
the  Enter Button until “Printing Setup” is displayed. 

 Note: To switch back-and-forth between the RS-232C Serial interface and an optional interface (if 
installed), you may continue to the  Enter Button until “Interface Now ‘interface’” is displayed.  
After the  Enter Button is released, the alternate ‘interface’ will be selected and the setup 
information for the newly selected interface will be printed.  (This is merely a shortcut method and 
accomplishes the same result as using the Interface Configuration Menu.  This feature was added in 
printer firmware version 2.1.) 

 

 

 

RS-232C Serial Interface 

To communicate using the Serial interface, “Serial” must be selected in the Interface Menu as described on 
page 21.  If there is no optional interface installed, Serial will be the only interface available.  When using the 
Serial interface, the baud rate, data bits, parity, stop bit(s), and handshaking method (XON/XOFF, ETX/ACK, 
RTS/CTS) must be set to match the settings on the host computer.  If these settings do not match, errors and/or 
lost data may occur.  The serial connector is an “RJ” type connector located on the side of the printer.  The pin 
assignments are shown below. 

 

 
Pin # Signal Description                              

1 COM Logic Common 
2 TXD Transmit Data (From Printer) 
3 RXD Receive Data (From Host) 
4 CTS Clear To Send (From Printer) 
5 COM Logic Common 
6 RTS Request To Send (From Host) 

Figure 11 - Serial Interface 
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Interfacing to a Host Computer 

IrDA Interface 

In addition to the standard Serial interface, your MLP 3040 may be equipped with an optional IrDA interface.  
IrDA interfaces are commonly found on many PDA’s and notebook computers.  To communicate using the 
IrDA interface, “IrDA” must be selected in the Interface Menu as described on page 23. 

The IrDA interface uses infrared light to provide a cable free, short range interface.  Since the communications 
medium is light, it is “line-of-sight” and requires that the interfaces on the printer and the host device be aligned 
with, or pointed at, each other.  The printer’s transmitter and receiver are located behind an “IrDA Window” as 
indicated in Figure 12. 

Whenever a host computer has established a connection with the printer, the  Wireless Indicator will 
illuminate. 

 Note: The printer’s IrDA implementation makes use of IrCOMM rather than IrLPT.  As a result, some host 
systems will require that the printer connection be established using a “COM” port rather than 
selecting “IrDA”.  In most PDA’s, for instance, this will be “COM3”. 

 

 

LCD Display 

Wireless Indicator 

 IrDA Window 

 

Figure 12 – Wireless Indicator & IrDA Window 

 

 

 

 

Bluetooth® Interface 

In addition to the standard Serial interface, your MLP 3040 may be equipped with an optional Bluetooth 
interface.  Bluetooth interfaces are built into some PDA’s and may be added to most others.  Bluetooth 
interfaces may also be added to notebook or desktop computers.  To communicate using the Bluetooth® 
interface, “Bluetooth” must be selected in the Interface Menu as described on page 24. 

The Bluetooth interface uses wireless, radio frequency signals to communicate, which eliminates the line-of-
sight requirement imposed by the IrDA interface. 

The MLP 3040 Bluetooth interface acts as a “serial port adapter” operating as a “server”.  Being a serial port 
adapter means, the printer may appear as a “Serial Device” when discovered, rather than as a “Printer”.  
Operating as a server, other devices such as a PDA or other host computer may initiate the connection to the 
printer.   
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Interfacing to a Host Computer 

When discovered, the default name that will appear will be “MLP 3040-aaannnnn” where “aaannnnn” is the 
printer’s serial number.  To obtain the printer’s Bluetooth name, you may use the printer’s Setup menus or you 
may have the printer print it out.  To print all the configuration for the interface, press and hold the  Enter 
Button until “Printing Setup” is displayed. 

Whenever a host device has established a connection to the printer, the  Wireless Indicator will be lit.  When 
the host closes the connection, the indicator will turn off.  To conserve battery power, application programs 
should disconnect from the printer whenever possible. 

 

 

Wi-Fi® Interface 

In addition to the standard RS-232C Serial interface, your MLP 3040 may be equipped with an optional Wi-Fi 
interface.  Wi-Fi interfaces are built into some PDA’s and may be added to most others.  Wi-Fi interfaces may 
also be added to notebook or desktop computers and as an “access point” to a wired network.  To communicate 
using the Wi-Fi interface, “Wi-Fi” must be selected in the Interface Menu as described on page 26. 

The Wi-Fi interface uses wireless, radio frequency signals to communicate, which eliminates the line-of-sight 
requirement imposed by the optional IrDA interface. 

The MLP 3040 Wi-Fi interface acts as a server and will accept connections from a host device such as a PDA, 
notebook computer, or a network server. 

The MLP 3040 Wi-Fi interface conforms to the IEEE 802.11b standard.  The factory default settings for this 
interface are: 

 WLAN Type: Infrastructure 
 WLAN SSID: any 
 WLAN WEP Bits: 0 (Off) 
 WLAN Auth: Auto 
 IP Address Assign: DHCP (The DHCP name will be “MLP 3040-aaannnnn”  
   where “aaannnnn” is the printer’s serial number.) 
 Port: 8023 
 

These settings for the Wi-Fi interface features may be modified using the Interface Setup Menu as described 
beginning on page 26 with the exclusion of the IP Port.  Note that changing the values of some of these features 
may cause additional features to be displayed.  For instance, changing WLAN WEP Bits from “0”, or Off, to 
“64” or “128” will cause the “WEP Key 1-4” features to be displayed so that the appropriate sized encryption 
key(s) may be entered. 

To print out the current Wi-Fi configuration details, you may press and hold  Enter Button until “Printing 
Setup” is displayed.  This feature is especially useful for obtaining the current IP address when assigning 
addresses via DHCP.  When doing so, be sure to wait several seconds after turning the printer on to allow it to 
establish a connection with the network and be served an address. 

The  Wireless Indicator will light whenever the printer is currently receiving a print job. 

When operating in Infrastructure mode, the printer will attempt to conserve battery power whenever possible by 
placing the Wi-Fi interface into a low power mode when not communicating.  However, according to the IEEE 
802.11b standard, the printer must be granted “permission” from the network’s Access Point before operating in 
the low power mode.  Since different Access Point manufacturers implement this feature differently, the amount 
of power saving actually achieved varies.  The actual power saving also varies with the amount of network 
traffic. 

35 





 

Power Considerations 

MLP 3040 printers are designed to provide superior output using as little power as necessary.  This provides the 
longest possible battery life.  The printers may also be operated from an external power supply when used in a 
more permanent installation in a vehicle or office.  The following discussions indicate how the printer 
accomplishes this power conservation using features such as Standby and Auto Power Down.  For more 
information on battery charging, please refer to “Charging the Battery” on page 40. 

 

 

Standby Operation 

When operating on battery power, the printer automatically enters a Standby mode one minute after last 
receiving data, printing, a front panel button is pressed, or a magnetic card reader swipe operation.  When in 
Standby, the printer will flash the  Power Indicator. 

While in Standby the printer turns off as many power consuming components as possible.  However, the printer 
remains fully capable of receiving data or responding to a control panel button.  The printer will automatically 
“wake up” when it begins to receive data from a host system, or when any front panel Button is pressed. 

 

 

Auto Power Down 

To conserve even more battery power, the printer may also be configured to turn itself off after a specified 
number of minutes of inactivity.  When the printer powers down, this is equivalent to turning the printer off 
using the  Power Button and the printer will no longer respond to incoming data. 

To enable the Auto Power Down feature, please refer to the Options Menu settings beginning on page 29. 

 

 

Operation Without A Battery 

MLP 3040 printers may be operated with an optional power supply and without a battery installed.  Power 
supplies are available for use with 100-240VAC/50-60Hz and for 12/24VDC vehicle applications.   

 Caution: Use only Psion Teklogix power supplies designed specifically for your MLP 3040 printer.  Using a 
different power supply may cause damage to the printer and will not be covered by the printer’s 
warranty. 

 Note: When the printer is connected to an external power supply, the printer will not enter Standby as 
described above. 
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Maintenance and Troubleshooting 

Cleaning 
In normal environments, the printer should be cleaned after printing a few rolls of paper or if there are voids in 
the printout.  For optimum performance and life, you should clean the Print Head and Platen Roller whenever 
you load new paper.  If your printer is an MLP 3040 SL model, you should also clean the Pick Roller. 

To clean the printer areas as described below, use a Thermal Head Cleaning Pen and MCR Cleaning Card 
available from Psion Teklogix, or you may use cotton swabs moistened with isopropyl alcohol.  Please refer to 
Figure 13 for the following instructions. 

 

Pick Roller 
(SL Only) 

MCR Slot Print Head 

Black Mark 
Sensor 

Tear Bar 

Black Mark 
/Gap Sensor 

(LP Only) 

Platen Roller 

Figure 13 - Printer Cleaning Areas 

• Turn the printer off.  Open the Paper Door and remove the paper roll or cassette. 
• Using a Thermal Head Cleaning Pen, clean the surface indicated on the Print Head. 

Caution: Do not use sharp objects to clean the print head.  This may damage the printer and require 
service.  Such damage is not covered under warranty. 

• Clean the Black Mark Sensor below the print head. 
• Clean the Tear Bar 
• If your printer is an MLP 3040 SL model, clean the Pick Roller.  (The roller only turns in one 

direction.) 
• Clean the Platen Roller.  Turn the platen roller with your finger to clean the entire surface. 
• If your printer is an MLP 3040 LP model, clean the Back Black Mark/Gap Sensor on the paper lid. 
• If a Magnetic Card Reader is installed, pass an MCR Cleaning Card through the MCR slot to clean the 

head. 

You may also experience a build up of paper dust in the printer.  This may be removed using a can of 
compressed air or by vacuuming. 
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Maintenance and Troubleshooting 

To clean the exterior of the printer, turn the printer off and use a soft cloth moistened with a mild detergent. 

Battery Care 

Charging the Battery 

The printer’s battery is charged in the printer using an optional power supply.  Power supplies are available for 
100-240VAC/50-60Hz and for 12/24VDC vehicle applications.  Follow the steps listed below to charge the 
battery.  An optional external two-bay charger is also available. 

• Plug the power supply into a power source appropriate for the adapter being used. 

• Plug the power supply into the power connector on the side of the printer.  The printer’s battery 
charging circuitry will analyze the condition of the battery and begin charging it if necessary. 

• If the battery is not fully charged, charging will begin and the  Battery Indicator will illuminate. 

• When the battery is fully charged, the  Battery Indicator will turn off.  Charging may take up to 2½ 
hours depending on the condition of the battery. 

• The printer may be used while the battery is charging, but this will extend the time required to fully 
charge the battery. 

• The power supply may remain connected to the printer to keep the battery fully charged and will not 
cause damage to the printer or battery. 

The printer’s battery status is displayed in the lower right corner of the front panel LCD Display.  The status is 
displayed as a battery shape which indicates the relative capacity that remains as indicated below. 

Fully Charged      Discharged 

Additional Battery and Safety Information 

• All MLP 3040 series printers us a 7.4 volt 2200mAH Lithium Ion battery. 

• The recommended ambient temperature for charging is 68-77° Fahrenheit (20-25° Centigrade). 

• Take the battery out of the printer when storing the printer for long periods of time.  The battery 
storage temperature is 40-104° Fahrenheit (4-40° Centigrade).  Do not store a fully charged battery at 
temperatures above this range for long periods of time or the battery may permanently lose charge 
capacity. 

• Do not disassemble, short circuit, heat above 80°C, or incinerate the battery. The battery may explode. 

• Only dispose of used batteries according to your local regulations.  If you do not know 
your local regulations, the Rechargeable Battery Recycling Corporation (RBRC) is a 
non-profit organization created to promote recycling of rechargeable batteries.  For more 
information visit www.rbrc.org. 
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Maintenance and Troubleshooting 

Testing the Power Supply and Battery 
To verify that the printer’s internal battery charger is functioning properly, perform the following steps. 

• Test the power adapter (100-240VAC/50-60Hz, 12/24VDC adapter) with a voltmeter to verify that its 
output voltage is 9 VDC. 

• Connect the power supply to a power source and then connect it to the printer. 

• Verify that the printer’s  Battery Indicator is illuminated.  If illuminated, the charging circuit is 
functioning properly.   

Note:  that if the battery is already fully charged, the  Battery Indicator will turn off after a short 
time. 

• After the battery has been charged for five minutes, disconnect the power supply. 

• Perform a printer Self-Test. 

o Make sure the printer is turned off.  The power indicator will be off and the LCD Display will 
be blank. 

o Press and hold the  Paper Feed Button. 

o Continue holding the  Paper Feed Button and turn the printer on using the  Power Button 
until “Printing Current Menu Values” is displayed. 

• If the printer successfully prints the Self-Test, the battery is functional.  If the Self-Test does not 
complete and the printer turns itself off, repeat this test with a known good battery. 

• Once this test has completed successfully, allow the battery to fully charge.  At the end of this time the 
 Battery Indicator will turn off.   

Note: If the printer is turned on, the battery status shown in the bottom right corner of the LCD 
display will always show a “full” battery whenever the printer is connected to the power 
supply. 

If the printer and battery do not appear to successfully pass these tests, refer to the Troubleshooting section for 
possible causes and solutions. 

Note: This test only verifies that the power adapter, the internal charging circuit, and the battery are 
functioning properly.  This test does not provide a valid indication of the relative capacity of the battery 
or how long it may hold a charge.  
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Maintenance and Troubleshooting 

Troubleshooting 

When encountering problems, the cause may be the printer or may sometimes be due to other problems with 
your system.  Please review the following tables to solve common problems you may encounter with your 
printer.  You may also visit www.psiontekgoix.com for additional “FAQ’s” that may assist you.  

If you are still unable to solve your problem, please contact the company where you purchased your printer 
since they are most familiar with your systems.  If they are unable to help you, you may contact Psion Teklogix 
Technical Support at (800) 322-3437. 

Error Messages 
Whenever the printer detects an error condition, the  Error Indicator will either flash or go to a steady on 
condition.  The indicator flashes for errors that can be easily corrected such as Check Paper or Paper Door 
Open. 

The indicator will stay on without flashing for errors that cannot be recovered without loss of data.  These are 
typically caused by interface configuration errors such as serial handshaking, or baud rate, and will require that 
the printer be turned off to clear the error. 

 

Message Possible Cause Solution 
Media supply is empty. Install new roll or cassette. Check Paper 
Paper/Black Mark sensor is dirty. Clean the Black Mark sensor.  

Refer to “Cleaning” on page 39. 
Paper Door Open Paper door not fully closed. Make sure the door is fully closed 

by opening the door and closing it 
again until the door “clicks” 
closed.  Check the platen roller for 
damage. 

Parity Error Serial I/O not configured correctly. Verify that the parity selection 
made in the Serial Interface Setup 
Menu matches the setting on the 
host system. 

I/O Overflow Serial I/O not configured correctly. Verify that the handshaking 
selections (ETX/ACK, 
XON/XOFF, RTS/CTS) selections 
made in the Serial Interface Setup 
Menu match the settings on the 
host system. 

I/O Error Optional interface – IrDA, Bluetooth, or 
Wi-Fi not responding. 

Try turning the printer off and on 
again.  If the error repeats, the 
printer requires service.   
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Maintenance and Troubleshooting 

Other Problems 

Problem Possible Cause Solution 
Battery not installed properly. Remove and reinstall battery 

making sure the battery release 
lever “clicks” when fully installed. 

Printer will not turn on. 

Discharged battery. Recharge battery. 
Auto Power Down is enabled. Change setting in Options Menu as 

described on page 29. 
Printer turns itself off. 

Battery discharged. Replace or recharge battery. 
Electrostatic discharge. May occur in extreme low 

humidity conditions.  Turn printer 
back on with power button. 

Battery already fully charged. No action required. 
Power supply not receiving power. Check building/vehicle circuit 

breakers/fuses. 
Faulty power supply. Check output of power supply with 

voltmeter.  9 VDC. 

 Battery Indicator does not light or 
does not stay lit when power 
supply is connected. 

Battery not installed properly. Remove and reinstall battery 
making sure the battery release 
lever “clicks” when fully installed. 

Battery not charging. Faulty power supply or battery. Refer to “Testing the Power 
Supply and Battery” on page 41. 

Low battery. Check and recharge battery. 
Print head dirty. Clean print head.  Refer to page 39.

Poor print quality. 

Poor quality or “old” paper. Verify paper from approved 
source.  Try new roll or cassette of 
paper. 

Obstruction in paper path or paper 
improperly installed. 

Check paper path and reinstall 
paper. 

Paper not feeding. 

“SL” model does not pull paper 
from cassette. 

Clean Pick Roller.  Refer to page 
39. 

Poor quality paper. Verify paper from approved 
source. 

Poor quality paper. Verify paper from approved 
source. 

Paper not feeding reliably or print 
is compressed vertically 

Heavy or thick forms or labels. 
Specialty paper with slick finish. 

Lower the Max Paper Speed as 
described on page 19. 

Low Battery. Check and recharge battery. Print Garbled. 
Improper serial interface 
configuration. 

Verify printer and host settings 
match.   

Low Battery. Check and recharge battery. 
Paper not loaded correctly. Check paper path and reinstall 

paper. 

Printer will not print. 

Improper interface configuration. Verify printer and host settings 
match.  Use test print to verify 
printer setting and to verify printer 
is functioning properly. 

Interface not configured correctly. With printer on, press and hold the Cannot print via optional interface, 
 Wireless Indicator does not 

light. 
 Enter Button to print out current 

configuration.  Make sure the 
interface is selected and Make sure 
printer and host set ups match. 
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Maintenance and Troubleshooting 

 

Obtaining Service 

If service is required for your printer, please contact the company where you purchased your printer.  If they are 
unable to assist you, contact Psion Teklogix Customer Service at (800) 322-3437 to obtain the name of the 
nearest Psion Teklogix Authorized Service Center. 

If you wish to return your printer to Psion Teklogix for service, please contact Psion Teklogix Customer Service 
at (800) 322-3437 to obtain a Return Authorization Number.  Units returned without a Return Authorization 
will not be accepted. 
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Advanced Setup Features 

 

An additional security menu is available for system administrators who prefer to “lock out” operator changes to 
the various menus.  This method of security can be set independently for the Format Menu, the Interface Menu, 
or the Options Menu. 

When set to Edit Allowed, the user is allowed to make changes to any item in the menu specified.  When 
set to View, the operator can review the settings, but cannot edit, or change, the values.  When set to 
Initialize, the printer will reset all values in that menu and any associated submenus to the factory default 
values and security will be reset to Edit Allowed. 

To be able to access the Security Menu, you must press and hold the  Increment Button rather than use the 
normal “hold the  Enter Button during power on” method.  Once Setup is entered, press the  Advance Button 
to cycle through the menus until “Security Menu” is displayed.  You may then press the  Enter Button to 
advance through the items as listed below. 

 

 

 SECURITY MENU 
 

 

Format Menu Format Menu 
Edit Allowed

 

Possible Values:  Edit Allowed*, View Only, Initialize

This feature selects whether the items in the Format Menu can be edited, or only viewed by the operator.  
Initialize will reset all the features for all formats to factory default values. 

 

Interface Menu Interface Menu 
Edit Allowed

 

Possible Values:  Edit Allowed*, View Only, Initialize

This feature selects whether the items in the Interface Menu can be edited, or only viewed by the operator.  
Initialize will reset all the features for all interfaces to factory default values, including the optional 
Bluetooth and Wi-Fi interfaces. 

 

Options Menu Options Menu 
Edit Allowed

 

Possible Values:  Edit Allowed*, View Only, Initialize

This feature selects whether the items in the Options Menu can be edited, or only viewed by the operator.  
Initialize will reset all the options to factory default values. 
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Print & Font Samples 

Print Samples 
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Print & Font Samples 

Courier Font With International Extended Character Set 

  
 

 

 

Courier Font PC Line Drawing Extended Character Set 
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Print & Font Samples 

Sans Serif Font 
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Specifications 

Printer Specifications 

Printing Specifications 

 Printing Method: Direct Thermal, Up To 3.3 Inches Per Second 
 Printing Resolution: 203 dots per inch (8 dots per mm) 
 Printing Width: 832 Printing Elements for up to 4.1″ (10.41 cm) 

Fonts/Characters/Bar codes 

 Fonts: A wide range of font types and sizes, from ~ 6 cpi to 34 cpi plus scaling depending 
on emulation chosen 

 International Characters: Arab-T, Arab-S, Arab-E, Asian fonts and an expanding catalog available for 
download 

 Bar Codes: Code 39, Code 128, UCC/EAN-128, UPC/EAN/JAN, Interleaved 2 of 5, 
CODABAR, EAN08 & 13, PDF-417, UPC 

 Downloads: Downloadable fonts, graphics, and logos 

Connectivity 

 Serial: RS-232C (Standard) 
 Wireless: IrDA, Bluetooth, Wi-Fi, Custom RF (Options) 
 Emulations: Printek, Printek Mt3, O’Neil, ZPL-II, CPCL 
 Software Available: Drivers for Windows 98/2000/XP.   

Print Utilities for Pocket PC and Palm OS.   
SDK’s for Pocket PC and Palm OS.  
MLP Setup Remote Configuration Utility for Windows 98/2000/XP. 

Data Input 

 Magnetic Card Reader: 3 Track, Simultaneous Read (Option) 

Power Management 

 Battery: 7.4 V, 2200mAH rechargeable 2 cell Lithium Ion 
 Endurance: 500 pages or more than 2000 inches of print per charge 
 Internal Charging: 2½ hours (requires optional power supply) 
 Battery Free Operation: Printer may be used with optional external power supply, with or without battery 
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Specifications 

Physical Specifications 

 Size: MLP 3040 & MLP 3040 LP – 8.1 x 6.6 x 3.1 inches, 19.56 x 16.76 x 7.87 cm 
(LxWxH) 
MLP 3040 SL – 9.6 x 6.6 x 2.0 inches, 19.56 x 16.76 x 5.08 cm (LxWxH) 

 Weight: 2.2 lbs. (1.0 kg) with battery 

Environmental Specifications 

 Operating Temp: 10° to 122°F (-12° to 50°C) 
 Storage Temp: -4° to 140°F (-20° to 60°C) 
 Humidity: 10% to 90% RH (non-condensing) 
 Rating: IP54 per IEC 529, without optional environmental case 

Operator Controls and Indicators 

 Display: 2 line x 16 character LCD 
 Indicators: Power, Wireless Connection, Magnetic Card Reader Ready, Battery Status, Fault 
 Controls: Power, Paper Feed, and two Configuration Buttons 
 Sensors: Paper, Paper Door Open, Black Mark Detection, and Label Gap Detection (LP 

Models Only) 

Memory Capacity 

 Flash: 1MB Program Memory; 1MB Font, Logo and Graphic Storage 
 RAM: 1MB 
 EEPROM: For Nonvolatile Configuration Storage 

Durability and Reliability 

 Drop Test: Survives multiple 4 foot drops to concrete (each face), conforms to IEC 68-2 
 MTBF: 10,000 hours @100% duty cycle in normal use 

Regulatory Approvals 

 Approvals/Markings: FCC Class B 
CE Mark 
UL listed AC adapters 
E-mark on In-Vehicle adapters 

Warranty 

 Printer: One year including print head and battery. 
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Specifications 

Media Specifications 

Receipt Paper 

 General Specifications: 0.0022 to 0.0065” (0.056 to 0.089mm) Thick 
Black Mark Sensing On Printed Side  
(Black Mark Sensing On Back Side and Gap Sensing On MLP 3040 LP Models) 

MLP 3040, MLP 3040 LP: 3 to 4.125” (76.2 to 104.78mm)Wide  
 (Roll Media)        0.750” (19.05mm) Inside Diameter Core 

2.625” (66.68mm) Maximum Outside Diameter 
 MLP 3040 SL: 3 to 4” (76.2 to 101.6mm) Wide 
 (Preloaded Cassette)  6” Maximum Length 

100 Sheets Maximum Per Cassette 
 Approved Vendors: Kansaki:  P300, P310, P350, P354, P390*, P530UV, TO281CA,  

               OP200, TO381N, F180, F380, F550 
  Jujo:  TF-50KS-E2C 
  Honshu:  FH65BV-3 
  Appleton:  Resiste 900-3.0* 
     *Standard Psion Teklogix Offering 
 

Labels 

 MLP 3040: 0.0022 to 0.0065” (0.056 to 0.089mm) Thick 
0.750” Inside Diameter Core  
Black Mark Sensing On Printed Side 
2.625” Maximum Outside Diameter  
4.125” Maximum Width (carrier) 

 MLP 3040 LP: 0.0022 to 0.0065” (0.056 to 0.089mm) Thick 
0.750” Inside Diameter Core  
Black Mark Sensing On Printed Side Or Back Side 
Gap Sensing Between Labels  
2.625” Maximum Outside Diameter  
4.125” Maximum Width (carrier) 
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Specifications 

Black Mark Position 

The vertical position of a Black Mark is dependent on the application program that will be used to search for 
and print relative to the mark.  The following diagram shows the optimum position when seeking the Black 
Mark at the beginning of a print job and will require little, if any, reverse paper motion.  (Note that reverse 
paper motion in MLP 3040 SL models is not supported.) 

The Black Mark must be printed on the front side of the paper for the MLP 3040 and MLP 3040 SL models.  It 
may optionally be printed on the back side of the paper for use with the MLP 3040 LP models 

 

 

 

 

 

 

 

 

 

 

 

 

 

0.7092”

0.15” 

Tear edge. 

Front (thermal printed) side of form. 

Black Mark should span width of paper for 
best results. 

 

Figure 14 - Black Mark Position 

 
 
 

Gap Sensing Specifications 

Gap Sensing is only available for MLP 3040 LP models.  The minimum gap between labels is 0.125” (3.2mm).  
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Specifications 

Supplies and Accessories 

Supplies 

 Battery: 7.4V, 2200 mAH Li-Ion 
Available separately or in 5 or 20 packs. 

 Receipt Paper – Rolls: 4.125” Width * 
Available in cases of 36. 

Receipt Paper – Cassettes: 4” Wide x 6” Long * 
Available in cases of 36 cassettes of 100 pages each. 

 Labels – Rolls: 4 x 6”, 4 x 4”, or 4 x 3” * 
Available in cases of 36. 

 
  *Other sizes available on request. 
 
 

Accessories 

 Power Supplies: 100-240VAC/50-60Hz Wall Adapter 
12/24VDC Vehicle Adapter 

 Battery Charger: Four Bay Fast Charger 
 Carrying Options: Shoulder Strap 
 Mounting Options: Fixed Vehicle Mounting System 

Adjustable Vehicle Mounting System 
Hand Truck Mounting System 
Wire Cart Mounting System 

 Cables: Serial RJ to DB-9F 
Serial RJ to Pigtail 
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Glossary of Terms 

802.11 Wireless networking communication standards created by IEEE. 

access point An interface between a wireless network and a wired network. 

Ad-Hoc A Wi-Fi network consisting of only stations (no access point).  Same as Peer-
to-Peer. 

ASCII American Standard Code for Information Interchange. 

authentication The process a Wi-Fi station uses to identify itself to another station.   

bandwidth The amount of data that be transferred in a given period of time. 

baud rate The rate at which characters are transmitted over a serial interface.  This is also 
often referred to as bits per second. 

binary Base two numbering system.  Digits are represented by the characters 0 and 1. 

bit A single binary digit. 

Bluetooth A definition for short range radio frequency communications. 

client Any node on a network that requests services from another node (server). 

control code A single, non-printing character which is used to control the configuration or 
operation of the printer. 

character pitch The horizontal spacing of characters.  Measured in cpi. 

cpi Characters per inch. 

current line The line upon which the next character will be printed. 

current print position The column on the current line where the next character will be printed. 

default Value or configuration assumed when the printer is powered on or reset. 

DHCP Dynamic Host Configuration Protocol.  A method used to centrally control the 
assignment of IP addresses on a network. 

dpi Dots per inch.  Generally used to refer to graphics density or resolution. 

escape sequence String of characters beginning with the escape (ESC) character which is used to 
control the configuration or operation of the printer.  The characters which are 
part of this string are not printed. 

font A group of characters of a given shape or style. 

hexadecimal Base sixteen numbering system.  Digits are represented by the characters 0 
through 9 and a through f. 

IEEE Institute of Electrical and Electronic Engineers 

infrastructure A Wi-Fi network consisting of stations connecting to a wired network or other 
stations via an access point. 

interface The connection between the printer and the host computer. 

57 



Glossary 

IP Internet Protocol.  A specification for packets, or datagrams, of data and an 
addressing method to allow the exchange of data with another system.  Must be 
combined with another protocol such as TCP to create a complete connection 
with the other system. 

LAN Local Area Network. 

LCD Liquid crystal display.   

LED Light emitting diode. 

line pitch The vertical spacing of rows of characters.  Measured in lpi. 

lpi Lines per inch. 

margin An area along any edge of a form where data may not be printed. 

MSB Most significant bit.  In a character, this refers to bit seven (of 0 to 7). 

node Any device connected to a network. 

parity A method used for detecting errors within a single character transmitted or 
received via an interface. 

Peer-to-Peer A network consisting of only stations (no access point or central server).  Same 
as Ad-Hoc. 

reset Initialization of various operating parameters of the printer to the value or state 
assumed when the printer is powered on. 

RS-232C An EIA standard for serial data transmission. 

server Any node on a network that provides services to another node (client). 

SSID Service Set IDentifier.  An identifier attached to packets on a Wi-Fi network 
that identify the particular network the packets are intended for. 

TCP Transmission Control Protocol.  A specification that controls the connection 
between systems on a network. 

top of form The vertical position where the first line is printed on the paper.  Also the 
position the paper is advanced to when a form feed (FF) character is received 
from the host or the Form Feed button is pressed on the printer's control panel. 

WAN Wide Area Network.  Refers to connections that allow one LAN to 
communicate with another LAN(s). 

WEP Wired Equivalent Privacy.  A security protocol for wireless LANs designed to 
provide data security similar to a wired LAN. 

Wi-Fi Refers to any of the IEEE 802.11 standards. 

WLAN Wireless Local Area Network.  A LAN made up of wireless nodes. 
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